Contents

1 Tekla Structures 10.1 Full Detailing ................................................................. 3
   1.1 General ........................................................................................................ 4
   1.2 Modeling..................................................................................................... 4
   1.3 Drawings .................................................................................................... 11
   1.4 Import and export .................................................................................... 20
   1.5 Custom components .................................................................................. 21
   1.6 Components ............................................................................................. 24
   1.7 Analysis and design .................................................................................. 34
   1.8 Reinforcement .......................................................................................... 42

2 Tekla Structures 10.0 Steel Detailing ............................................................ 51
   2.1 General ....................................................................................................... 52
   2.2 Modeling ................................................................................................... 57
   2.3 Drawings ................................................................................................... 66
   2.4 Import and export ..................................................................................... 73
   2.5 Custom components .................................................................................. 75
   2.6 Components ............................................................................................. 81
Tekla Structures version 10.1 is a main release and contains many new features and fixes.

**Compatibility**

Tekla Structures 10.1 is compatible with all previous versions. You can open and work with existing models using Tekla Structures 10.1.

We recommend that you complete any models you have started using your current version.

> Once you save a model in Tekla Structures 10.1, you can no longer open it in older versions of Tekla Structures, or in Xsteel or Xengineer.

**Installing**

Tekla Structures setup creates a new subfolder for Tekla Structures 10.1.

You need Windows Administrator rights to install Tekla Structures 10.1. This ensures that all Windows system folder *.dll files are updated.

**Topics**

This chapter is divided into following sections:

- **General** (p. 4)
- **Modeling** (p. 4)
- **Drawings** (p. 11)
- **Import and export** (p. 20)
- **Custom components** (p. 21)
- **Components** (p. 24)
- **Analysis and design** (p. 34)
- **Reinforcement** (p. 42)
1.1 General

This section describes the following new features and fixes:

Performance improvements

Tekla Structures 10.1:

• Uses virtual memory more efficiently, so you get fewer warnings about low memory.
• Uses less memory when you open and close views, or switch between rendered and wire frame views.
• Handles large values in user-defined attributes more accurately.

Snapping improvements

Tekla Structures 10.1 includes the following new features and fixes:

• The Snap to intersection points switch now also affects intersections that are inside objects, for example, intersections inside reference models and intersections of part centerlines in drawings.
• The environment variable XS_PIXEL_TOLERANCE now correctly adjusts the search area of snap switches.

1.2 Modeling

This section describes the following new features and fixes:

Improved display in model views

We have improved the way Tekla Structures displays models in rendered views.

• Tekla Structures highlights objects more clearly when you select them.
• Parts look better when you use the Shaded wire frame option.
• Distances are easier to perceive when you use the Rendered option, as distant objects are darker than close ones.
New snap settings

Use the new list box on the Snap settings toolbar to snap to either the boundary planes or outline planes of objects:

For more information on snapping and plane types, see the following topics in the online help:

- Specifying points
- Snapping
- Plane types
Making models parametric

In Tekla Structures 10.1 you can make models parametric by creating dependencies between the planes and handles of model objects. For example, you might make the offset of columns from a wall dependent on the location of the wall; so, if you move the wall, the columns follow.

The Points toolbar includes two new tools that you can use to create these dependencies:

- Click the Create reference distance icon to create a reference distance between model objects that you can use in calculations in the Model browser and Variables dialog boxes. See also Creating reference distance variables (p. 23).
- Click the Create distance icon to bind model objects together. See Creating distance variables in the online help.

In the model, Tekla Structures displays reference distances in orange.

Use Rendered representation for parts to make it easier to select object planes.
You can also define variables and formulas for models, and use magnetic planes.

The **Tools** toolbar contains the new tools to open the **Variables** and **Model browser** dialog boxes for model objects:

For more information on parametric objects, see **Editing custom components** and **Defining variables** in the online help.

### Assigning control numbers to parts

Control numbers are attributes that identify the location of parts in a model. Each part gets a unique control number. You can have Tekla Structures assign consecutive control numbers to all parts in the model, to selected parts, or only to parts in a specific numbering series.

To display control numbers in reports, drawings, or when you use the **Inquire > Object...** command, select the attribute, ACN.

To assign control numbers to parts in a model:

1. Ensure that numbering is up to date (**Tools > Numbering > Modified**).
2. Click **Tools > Numbering > Create control numbers...** to open the **Create control numbers** dialog box:
3. Indicate which parts to consider:
   - To consider all parts in the model, do not select any parts,
   - To only consider specific parts, select the parts.

4. Specify which parts get control numbers, using the **Numbering** list box:
   - To create consecutive numbers for all parts, select **All**,
   - To create control numbers for parts in a specific numbering series, select **By numbering serie**; then enter the prefix and start number of the numbering series in the **Numbering serie** fields.

5. To define the control numbers, go to the **Start number** field and enter the first control number to use; then enter the interval in the **Step value** field. For example, to assign the control numbers 2, 5, 8, 11, etc., enter 2 in the **Start number** field and 3 in the **Step value** field.

6. If some parts already have control numbers, use the **Renumber** list box to specify how to treat them: Select **Yes** to replace existing control numbers, **No** to keep them.
7. Use the **Sort order** list box to specify in what order to assign control numbers, according to the location of each part on the global coordinate system. The options are **None**, **X-Y-Z**, **Y-X-Z**, **Z-X-Y**, and **Z-Y-X**. In the following example, the sort order is **X-Y-Z**.

![Diagram showing parts labeled 1 to 4 in a coordinate system.]

8. To assign control numbers to parts, click **Apply**; then **Create**.

See also **Displaying control numbers in drawings** (p. 15).

### Reference model improvements

Tekla Structures 10.1 includes the following new features and fixes:

- You can now use reference models in the Viewer and Project Management configurations.
- Tekla Structures now hides the parts of reference models that are outside the work area.
- If you change reference model properties or visibility in a model view, Tekla Structures no longer shows the reference models in other views where they should be invisible.

### Load modeling

Tekla Structures 10.1 includes the following new features and fixes:

**Creating uniform loads**

To create uniform loads that do not have openings, simply pick the load corners once, and then click the middle mouse button (just like you do to create contour plates and concrete slabs). You no longer need to pick the first load corner again.
Fixes
Tekla Structures 10.1 includes fixes for the following:

- Tekla Structures did not filter loads in views if:
  - The loads were created using the Wind load generator (28) macro.
  - The load group name contained inch characters (").
- The Part names filter in the load properties dialog boxes did not work for plates.
- When Tekla Structures automatically creates and names load groups, it no longer uses existing load group names.

Miscellaneous
Tekla Structures 10.1 includes the following new features and fixes:

- The select filter and select switches now affect all commands that ask you to pick objects, chamfers, custom components, etc.
- If a part had end offsets (Dx, Dy, Dz), you could not snap to the part’s handles, even if the Snap to reference lines/points switch was active. Fixed.
- Tekla Structures no longer treats the segment ends of construction circles as intersections, so it is now easier to snap to the correct intersections.
- The Tools > Measure > Bolt measures command now creates the measures in the view in which you pick the bolt.
- If you changed the visibility settings of component symbols in model views, you had to redraw the window to change the blue macro symbols. Fixed.
- The view angle now updates correctly if you change a wire frame model view to rendered and the view angle from Plane to 3D at the same time.
- The Reference line part representation option now works in rendered model views.
- Sometimes parts seemed to disappear from rendered model views if you selected the Profile text checkbox in View properties > Display > Advanced. Fixed.
- If you tried to modify or delete locked model objects and clicked OK in the warning dialog box, Tekla Structures ignored the visibility settings in model views and displayed all objects in them. Fixed.
• In the Steel Detailing configuration, reinforcing bars now move with the part that contains them.

• Opening a new or existing model when the Modify profile catalog or Modify material catalog dialog boxes were open sometimes caused an application error. Tekla Structures now closes these dialog boxes before opening a new or existing model.

• Tekla Structures now correctly calculates the center of gravity for polybeams when you use the Inquire object icon, regardless of the location of the work plane.

• If you copied polybeams that had connections, Tekla Structures placed the connection symbols in the global origin. Fixed.

• When you clicked the Get button, Tekla Structures sometimes took into account very minor differences in imperial bolt and stud distances and incorrectly grouped them together in dialog box fields (for example, 2*1'-5"5/16 1'-5"5/16 2*1'-5"5/16 instead of 5*1'-5"5/16). Fixed.

1.3 Drawings

This section describes the following new features and fixes:

Modifying drawing grids

Two new select switches on the Drawings: Select toolbar allow you to select grids or individual grid lines in drawings:

Select grids
Select grid lines

Double-click a grid or grid line to change its properties. This is useful when you want to:

• Not print grids or grid lines (use the background color of the drawing for grid lines and text to do this).
• Change a line type.
• Change a label (font, size, frame).
• Define a label location. You can now define different locations for the labels at each end of a grid or grid line.
Examples

If you have a drawing that contains different grids, one for the architect, another for the engineer, you can now easily hide one of the grids.
If the labels of two grids overlap, simply extend the grid lines of one grid to move its labels:

By default, the grid labels overlap.

Changing the length of one grid line makes each label distinct.

**Including reference models in drawings**

In Tekla Structures 10.1 you can include reference models in general arrangement drawings. For example, you could use 3D plant models or architectural drawings as reference models.

**Drawing level**

To show or hide reference models in drawings, and change their appearance:

1. Open the **General arrangement drawing properties** dialog box.
2. Click the **Reference model**... button. Tekla Structures opens the **General - reference object properties** dialog box. The **Contents** tab lists all the reference models included in the model:

   ![General - reference object properties dialog box](image)

   - **Content** column lists the reference models included in the model.
   - **Visibility** column allows you to select **Visible** or **Invisible** to show or hide each reference model.

3. In the **Visibility** column, select **Visible** from the list box to show the selected reference model in the drawing.
4. Go to the **Appearance** tab to select line color and type for all visible reference models.

**View level**

Use the **View properties** and **View reference object properties** dialog boxes to show and hide reference models in individual drawing views, independently of the properties of the drawing.

For more information on using reference models in Tekla Structures models, see **Reference models** in the online help.

**Showing part openings and recesses in drawings**

Tekla Structures 10.1 includes a new option to show openings and recesses (blind holes) in parts in drawings.

To do this, do one of the following:

- Open the drawing properties dialog box, and then click the **View...** button.
- Double-click the border of an existing view in a drawing.

On the **Attributes** tab, select **Yes** from the **Show openings/recess symbol** list box.
Tekla Structures indicates openings and recesses in the following way:

<table>
<thead>
<tr>
<th>Type of opening</th>
<th>Shown as</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hole through a part</td>
<td>Hole symbol</td>
<td><img src="image" alt="Hole symbol" /></td>
</tr>
<tr>
<td>Recess in the front face of a part</td>
<td>Recess symbol and bounding lines shown as unbroken lines</td>
<td><img src="image" alt="Recess symbol and bounding lines" /></td>
</tr>
</tbody>
</table>
| Recess in the back face of a part | Recess symbol and bounding lines shown as dashed lines  
  Remember to switch hidden lines on for parts. | ![Recess symbol and bounding lines](image) |

### Displaying control numbers in drawings

To display control numbers in drawings, include the attribute ACN in the part marks:

1. In the drawing properties dialog box, select **Part mark...** to open the part mark properties dialog box.
2. Select **User-defined attribute** in the **Available elements** list, and then click **Add>**.
3. Type "ACN" in the **Mark content - user defined attribute** dialog box; then click **OK** to close the dialog box:

![Mark content - user defined...](image)

4. Save the part mark and drawing properties.
Part mark improvements

Tekla Structures 10.1 includes the following new features and fixes:

**Updating marks in frozen drawings**
Tekla Structures now correctly updates and splits merged part marks in frozen drawings when some (but not all) of the parts sharing the mark have changed.

**Showing part marks for hidden parts**
To have Tekla Structures 10.1 show marks for hidden parts in drawings, use the environment variable `XS_PART_MARKS_ALWAYS_VISIBLE_IN_DRAWING`, followed by one or more of the following letters, to define the drawing type:

<table>
<thead>
<tr>
<th>Letter</th>
<th>Drawing type</th>
</tr>
</thead>
<tbody>
<tr>
<td>W</td>
<td>Single-part drawings</td>
</tr>
<tr>
<td>A</td>
<td>Assembly drawings</td>
</tr>
<tr>
<td>M</td>
<td>Multi-drawings</td>
</tr>
<tr>
<td>G</td>
<td>General arrangement drawings</td>
</tr>
<tr>
<td>C</td>
<td>Cast-unit drawings</td>
</tr>
</tbody>
</table>

Mark frames and leader lines appear as unbroken lines.

Examples
To show marks for hidden parts in assembly drawings:
```
set XS_PART_MARKS_ALWAYS_VISIBLE_IN_DRAWING=A
```

To show part marks in cast-unit and general arrangement drawings:
```
set XS_PART_MARKS_ALWAYS_VISIBLE_IN_DRAWING=CG
```

**Updated marks following parts**
Use the new environment variable `XS_UPDATE_MARK_PLACING_IN_DRAWING` to have Tekla Structures relocate updated marks in specific drawing types. Use the letters in the above table to specify the drawing types. By default, this environment variable applies to single-part, assembly, and multi-drawings.

Example
To relocate updated part marks in single-part, assembly, multi-, and general arrangement drawings:
```
set XS_UPDATE_MARK_PLACING_IN_DRAWING=WAMG
```

**Part number format in marks**
To specify the number of characters used to display part numbers in part marks when you use the template fields `ASSEMBLY_SERIAL_NUMBER` and `PART_SERIAL_NUMBER` in the User-defined attribute element, add a period (.) followed by the minimum number of characters after the field name.
Example

PART_SERIAL_NUMBER.3 creates part numbers with at least three characters (001, 002, 003, etc.).

Fixes
Tekla Structures 10.1 includes fixes for the following:

• Manually relocated part marks moved when you updated marks in general arrangement drawings, even if you had selected fixed from the Placing list box in the Part mark placing dialog box.

• Merging part marks did not work correctly if you used the template fields ASSEMBLY_SERIAL_NUMBER and PART_SERIAL_NUMBER in the User-defined attribute part mark element.

Dimensioning improvements
Tekla Structures 10.1 includes the following new features and fixes:

Dimensioning concrete parts
Tekla Structures now automatically shows the profile dimensions of concrete parts in cast-unit drawings. To prevent this, set the environment variable XS_DO_NOT_CREATE_PROFILE_DIMENSIONS_FOR_CONCRETE to TRUE.

Fixes
Tekla Structures 10.1 includes fixes for the following:

• Curved radial dimensions were incorrect if you used the Angle option.

• If you used triangles to show bevel dimensions, setting the environment variable XS_CHECK_TRIANGLE_TEXT_SIZE to TRUE did not adjust the triangle size to the text size.

• Setting the environment variable XS_USE_TUBE_INNER_LENGTH_IN_DIMENSIONING to TRUE did not dimension the overall length of SDP tube profiles along the inner surface.

Templates and reports
Tekla Structures 10.1 includes the following new features and fixes:

Numbering not required to create reports
You can now create reports without numbering the model objects, in all configurations of Tekla Structures. This is useful when you need to produce draft reports from large multiuser models. Tekla Structures still warns you if numbering is not up to date.
Strand reports
To create reports of prestressed strands, use the `cast_unit_strand_list` report template. This report lists the position, number, grade, size, and length of strands and the pull in each strand.

For more information on how to create reports, see Printing reports in the online help.

User-defined attributes in templates
You can now combine user-defined attributes in template fields. Use the following definitions in front of the attribute names:

- **UDA**: for text strings
- **UDA_N**: for numeric attribute values

**Examples**

- `=%UDA:DRAWING_USERFIELD_1% %UDA:DRAWING_USERFIELD_2%`
- `=%UDA_N:USER_FIELD_1% %UDA_N:USER_FIELD_2%`
- Modeled by `%UDA:MODELED_BY%` on `%UDA:MODELED_DATE%`

Fixes
The template field `CAST_UNIT_REBAR_WEIGHT` now works correctly.

Printing
Tekla Structures 10.1 includes the following fixes:

- Tekla Structures now only displays the warning **Folder not found** if you plot to a file and have not defined the file path.
- Plotting using the French XP driver for Xerox 8825 and then saving the model sometimes corrupted the model database, so you could not reopen the model. Fixed.
- Tekla Structures no longer prints the view frame around the key plan in drawings.

Miscellaneous
Tekla Structures 10.1 includes the following new features and fixes:

**Opening drawings with different Tekla Structures configurations**
You can now:

- Open any drawing type using any Tekla Structures configuration.
- Open and print drawings that are locked, or if numbering is out of date, in all configurations of Tekla Structures.
Snapping in the Drawing Editor

**Snap to nearest points** is now the lowest priority snap switch in the Drawing Editor. This makes it easier to accurately pick a point (for example, an end or midpoint) when the **Snap to nearest points** switch is active.

It is now also easier to snap to part centerlines and not hit the edge lines of thin parts, for example, I profile webs.

In some cases Tekla Structures did not find a point to snap to in drawings. This sometimes caused an application error. Fixed.

End views in included single-part drawings

To prevent Tekla Structures from creating end views when you create an assembly drawing and choose to include single-part drawings, set the environment variable `XS_NO_END_VIEWS_TO_INCLUDED_SINGLE_DRAWINGS` to `TRUE`.

If this environment variable is disabled or not defined in the `user.bat` file, Tekla Structures creates end views based on the single-part drawing properties.

Tolerance for overlapping part lines inside cast units

To define the distance within which Tekla Structures treats part lines inside cast units as overlapping, set the environment variable `XS_HIDDEN_LINES_CHECK_TOLERANCE`. The default value is 0.01.

Fixes

Tekla Structures 10.1 includes fixes for the following:

- The **Save as** and **Load** buttons did not work correctly in the **Assembly - neighbor part properties** and **Assembly - neighbor part mark properties** dialog boxes.

- Tekla Structures displayed holes for studs in assembly drawings.

- Tekla Structures did not revert to the original drawing if you modified the filter settings for neighbor parts and then changed them back.

- If you used a dimension line with a reinforcement mark to show the reinforcement distribution area, and then added a dimension point to the dimension line, the circle symbol at the intersection of the dimension line and the reinforcing bar disappeared.
• If a bolt connected several parts that had different holes, for example, normal and oversized holes, the hole diameter was incorrect in some bolt marks.

• Tekla Structures 10.0 omitted pull-outs from merged reinforcement marks for single bars and bar groups.

• Elevation marks were upside-down in cast-unit drawings if you set the environment variable XS_UPSIDE_DOWN_TEXT_ALLOWED to TRUE.

• Text you created using the Text along line command was not orthogonal, even if the Setup > Ortho setting was active.

• Tekla Structures did not copy the hatches when you copied or linked drawing views to another drawing.

1.4 Import and export

This section describes the following new features and fixes:

CNC

Tekla Structures 10.1 includes fixes for the following:

• If you used the Even option in the Slots list box in the Bolt properties dialog box to rotate slotted holes, they had the wrong direction in DSTV files.

• Tekla Structures included holes that were outside parts in the DSTV files.

Plate profiles in SDNF exports

To have SDNF exports convert plate profiles (PL) to contour plates, set the environment variable XS_SDNF_CONVERT_PL_PROFILE_TO_PLATE to TRUE. This works with SDNF versions 2.0 and 3.0.
3D DGN export

Tekla Structures 10.1 includes improvements to 3D DGN export, and a new 3D DGN dialog box:

![Export 3D DGN dialog box]

Enter the name of the export file, or click **Browse...** to locate it.

Click **Export selected** to export the parts you have selected.

Miscellaneous

Tekla Structures 10.1 includes fixes for the following:

- Construction lines were black when you used the **File > Import > DWG/DXF...** command and selected the **Use 2D import** checkbox in the **Import DWG/DXF** dialog box.

- Using DWG files that contained blocks as reference models sometimes caused application errors.

- When you published models as web pages, the position of the work plane affected the XML output.

- Tekla Structures did not update part locations correctly in XML imports if the location of part definition points changed less than 1000 mm.

1.5 Custom components

Tekla Structures 10.1 makes all the changes to custom components simultaneously, which makes them faster to use, and the changes more accurate. Tekla Structures 10.0 made the changes one handle at a time.
This section describes the following new features and fixes:

**More properties for custom components**

You have now more information available to build into your custom components. You can use user-defined attributes and template fields when you create links between custom component parameter variables and component object properties in the **Variables** and **Model browser** dialog boxes.

To use template fields, use the fTpl function, followed by the field name and object ID. For example, enter \=fTpl("WEIGHT",6290) in the **Formula** column in the **Variables** dialog box:

```
<table>
<thead>
<tr>
<th>Category</th>
<th>Name</th>
<th>Formula</th>
<th>Value</th>
<th>Value type</th>
<th>Variable type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Component parameters</td>
<td>P1</td>
<td>=fTpl(&quot;HEIGHT&quot;,6290)</td>
<td>777.15</td>
<td>Length</td>
<td>Parameter</td>
</tr>
<tr>
<td></td>
<td>P2</td>
<td>=fTpl(&quot;WIDTH&quot;,6290)</td>
<td>300.00</td>
<td>Length</td>
<td>Parameter</td>
</tr>
</tbody>
</table>
```

See also **Creating parameters that use formulas** in the online help.

Use the **Model browser** dialog box to set values for user-defined attributes:

![Model browser dialog box](image-url)
The part properties available for custom components also include **Name**, and the bolt properties include **Bolt type** (site or workshop):

### Creating reference distance variables

The **Custom component editor** toolbar contains a new **Create reference distance** icon. Use it to create reference distances to use in calculations in the **Model browser** and **Variables** dialog boxes.

A reference distance changes as you move the objects between which you created the distance, but you cannot move the objects by changing the reference distance. In the Custom Component Editor, Tekla Structures displays reference distances in orange.

By default, reference distance variables are hidden in the custom component dialog boxes. To show them, select **Show** in the **Visibility** column in the **Variables** dialog box.

For more information on distance variables, see **Creating distance variables** in the online help. See also **Making models parametric** (p. 6).

### Miscellaneous

Tekla Structures 10.1 includes the following new features and fixes:

- You can now create several system connections between the same main and secondary parts, using the Custom Component Editor, if the parts are included in a custom connection or seam. You must also include other objects in the custom component.
• You can now include system macros and custom components in custom components.

• If you have included custom components in another custom component, you can now change the properties of subcomponents using the dialog box of the main component.

• The Allow multiple instances of connection between the same parts checkbox in the Custom component wizard dialog box now works for custom connections and seams.

• Custom seams now have handles, which you can bind to planes and use when you create distance variables.

• Tekla Structures did not remove the square brackets indicating default values in custom component dialog boxes if you changed the values in the Profile or Material fields. Fixed.

• Tekla Structures rotated custom parts if you moved magnetic planes. Fixed.

• If several magnetic planes temporarily overlapped, they stuck together and one of the planes caught all objects on the planes. If you moved that plane, all objects moved. Moving the other planes did not move any objects. Fixed.

1.6 Components

To use components, press Ctrl+F to open the Component catalog dialog box and search for the component you want to use by name, number, or category. For more information, see Component catalog in the online help.
This section describes the following new features and fixes:

**New tower components**

Tekla Structures 10.1 introduces several new components, which you can use to detail tower bracing:

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="" alt="Bolted gusset brace (167)" /></td>
<td>Connects two continuous diagonal braces with two horizontal braces using a bolted gusset plate.</td>
</tr>
<tr>
<td><img src="" alt="Bolted bridge brace (169)" /></td>
<td>Connects three horizontal braces with a bolted gusset plate.</td>
</tr>
<tr>
<td><img src="" alt="Open/Close angle ends (1050)" /></td>
<td>Bends the end of an angle leg.</td>
</tr>
<tr>
<td><img src="" alt="Open/Close angle (1051)" /></td>
<td>Bends a portion of an angle leg.</td>
</tr>
</tbody>
</table>
Most of these components take default values from the following files, which must be located in the ..\environments\your_environment\system folder or the current model folder.

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ang_max.txt</td>
<td>Bolt end distance, edge distance, distance between bolts, bolt/hole tolerances.</td>
</tr>
<tr>
<td>bul_dim.txt</td>
<td></td>
</tr>
<tr>
<td>bul_pes.txt</td>
<td></td>
</tr>
<tr>
<td>bul_pin.txt</td>
<td></td>
</tr>
<tr>
<td>imb_com.txt</td>
<td></td>
</tr>
<tr>
<td>File</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>imb_dim.txt</td>
<td></td>
</tr>
<tr>
<td>note_pes.txt</td>
<td></td>
</tr>
<tr>
<td>pla_com.txt</td>
<td>Filler plate composition.</td>
</tr>
<tr>
<td>pla_dim.txt</td>
<td>Filler plate dimensions for each bolt diameter.</td>
</tr>
<tr>
<td>prof_pes.txt</td>
<td></td>
</tr>
<tr>
<td>ring_com.txt</td>
<td>Composition of filler rings.</td>
</tr>
<tr>
<td>ring_dim.txt</td>
<td>Ring washer dimensions.</td>
</tr>
<tr>
<td>slun_pes.txt</td>
<td></td>
</tr>
<tr>
<td>sp_lam.txt</td>
<td>Plate thickness.</td>
</tr>
<tr>
<td>std_gauges.txt</td>
<td>Bolt spacing for each bolt diameter and angle size.</td>
</tr>
<tr>
<td>std_gauges_12.txt</td>
<td></td>
</tr>
<tr>
<td>std_gauges_16.txt</td>
<td></td>
</tr>
<tr>
<td>std_gauges_20.txt</td>
<td></td>
</tr>
<tr>
<td>std_gauges_24.txt</td>
<td></td>
</tr>
<tr>
<td>wash_dia.txt</td>
<td>Outer diameter of the washer.</td>
</tr>
</tbody>
</table>
Array of objects (29)

Use the **Array of objects (29)** component to copy model objects along a line. If you modify the original object in this component, the copied objects change as well.

![Tekla Structures Array of objects (29)](image)

In this example, we copied cast-in fittings along an edge of a concrete part:
**Tapered column-beam stub (150)**

Tekla Structures 10.1 includes the following improvements:

- **Tapered column-beam stub (150)** now uses **U.S. Splice connection (77)** to create the splice. To create the splice, select **Specified** from the **Splice** list box on the **Parameters** tab and enter the name of the splice properties file in the **Parameter** field.

- Tekla Structures creates weld preparations for welds 1 to 7. **U.S. Splice connection (77)** automatically creates welds 8, 9, and 10.

- The upper flange alignment list box has been removed from the **Picture** tab.

Tekla Structures 10.1 also includes the following fixes:

- The lower flange of a built-up bracket is now aligned with the exterior face of the secondary part flange at the splice location.

- For rolled (profile) brackets, the lower flange cut and backing bar location is correct, and the flange and backing bar do not collide with the column or diaphragm.

- The root gap for rolled brackets at the upper flange is no longer doubled.

- Backing bars are welded to bracket flanges and attached to the assembly.

- When the lower flange of the bracket extends below the bottom diaphragm, the web ratheole is correct, and there are no welding problems.

- The upper flange weld is now along the face of the flange, not on the side of it.

- You can create a haunched bracket without stiffeners by setting stiffener thickness to 0.

- Sometimes the web was not welded to the lower panel. Fixed.

- Tekla Structures now uses the correct material and part mark information for the lower flange of the built-up brackets.
Beam to beam connections

Tekla Structures 10.1 includes fixes for the following:

**Stiffened shear plate (17)**
If you selected the Secondary member option from the Splice plate assembly list box on the Plates tab, Tekla Structures treated the splice plate as the main part in the assembly, not a secondary.

**Welded beam to beam (123)**
The beams collided, because this connection did not automatically chamfer the secondary beam based on the radius of the inner corner of the primary beam.

**Full depth S (185)**
Did not create tab plates correctly if you used chamfer options other than Line or Default.

Beam to column connections

Tekla Structures 10.1 includes the following new features and fixes:

**Haunch (40)**
The part prefix was incorrect for the flange plate of welded built-up haunches. Tekla Structures now uses the settings defined in Setup > Options.

**Defining stiffener size**
For Bolted moment connection (134), Moment connection (181), Column with stiffeners (182), (186), (187), and (188) components, use the Stiffeners tab to define stiffener size:

**Column with stiffeners W (182)**
Now creates weld backing bars correctly.

See also **Tapered column-beam stub (150) (p. 29)**
Splice connections

Tekla Structures 10.1 includes the following new features and fixes:

**U.S. Splice connection (77)**
Now correctly creates the filler plates (spacers) between the splice plates and the web or flange of the spliced parts. Filler plates no longer collide with the splice plates.

Bracing connections

Tekla Structures 10.1 includes the following fixes:

**Using flat bars**
When you use connections 10, 11, 20, 22, 61, and 62 Tekla Structures now searches folders for the ftprops.inp file, in this order:
1. Current model folder
2. Project folder
3. Firm folder
4. The profil folder under \environments\your_environment\.

**Bolted gusset (11)**
Now uses the correct value for bolt shear capacity when more than two layers of material are bolted together.

**Corner tube gusset (56)**
Now works correctly, even if the only secondary is a plate.

**Boomerang wrapped diagonal (58), Corner wrapped gusset (63)**
The number of shim plates is now an integer, not a distance.

Macros and details

Tekla Structures 10.1 includes the following new features and fixes:

**Concrete var beam (S52), Building (S58)**
Sometimes caused application errors. Fixed.
**Stairs (S71–S74)**

- You can now define the distance between steps and stringers:

- To define the rotation of steps in the **U pan (S71)** and **Wooden steps pan (S72)** components, use the **Steps rotation** list box on the **Parameters** tab.

- **U pan (S71)** and **Wooden steps pan (S72)** now only create holes in brackets when you create holes to connect brackets and steps.

- **U pan (S71)** now positions angle-profile brackets correctly, even for user-defined step profiles.

- The part and assembly position number fields appear in the correct order in the **U pan (S71)** dialog box.

- Tekla Structures now creates the bolt assemblies correctly. You can now also define bolt assemblies in **Wooden steps pan (S72)**.

- The **U pan (S71)**, **Polybeam pan (S73)**, and **Z pan (S74)** dialog boxes include the following new dimension:

**Railings (S77)**

Parts now have default values in the **Class** fields.

**Base plate (1004)**

In the US Imperial environment, the default value for bolt diameter was incorrect and caused **Bolt not found** warnings. Fixed.
Handrailing (1024)

You can now use details to connect stanchions. Add the details and connections you want to use to the following files:

- ..\applications\steel1\ts_page_10.inp
- ..\environments\*your_environment*\system\joints.dat

For more information, see Input files and Data files in the online help.

To use a detail or connection to connect stanchions, when you create the handrails, go to the Parameters tab and select it from the Stanchion connection type list box.

Tekla Structures now displays connection symbols for stanchion connections.

Component catalog improvements

Tekla Structures 10.1 includes the following new features and fixes:

- Arrow keys now work correctly when you scroll over two custom components in the Component catalog dialog box.
- When you select or start to create a component using the Component catalog dialog box, Tekla Structures no longer displays other icons on the component toolbars as if the associated commands were active.
- (French version) The component category names (Basics collection, Favorites, etc.) in the Component catalog dialog box are now also available in French.

Miscellaneous

Tekla Structures 10.1 includes the following new features and fixes:

- System macros now have handles, so you can bind them to planes, other objects, etc.
- The connection design check based on the AISC ASD Specification now also works for one-sided welds in connections 11, 60, 62, 134, 141–144, 146, 181, and 182. To indicate one-sided welds, set one of the weld sizes to 0.
- For connections 141, 146, 147, 149, 181, 184–187, and 189 Tekla Structures now uses the global coordinate system and creates all shear plates on the same side of the main parts.
- If you tried to modify several components at the same time and modifying any of them required another component to be modified, Tekla Structures only modified some of the components. Fixed.
1.7 Analysis and design

This section describes the following new features and fixes:

New design codes

Tekla Structures 10.1 includes the following new design codes:

### Steel design

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NS3472</td>
<td>Norwegian design code for steel</td>
</tr>
<tr>
<td>NPD</td>
<td>Norwegian design code for offshore steel</td>
</tr>
<tr>
<td>DS412</td>
<td>Danish design code for steel</td>
</tr>
<tr>
<td>BSK99</td>
<td>Swedish design code for steel</td>
</tr>
<tr>
<td>B7</td>
<td>Finnish design code for steel</td>
</tr>
</tbody>
</table>

### Concrete design

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NS3473</td>
<td>Norwegian design code for concrete</td>
</tr>
<tr>
<td>BBK94</td>
<td>Swedish design code for concrete</td>
</tr>
<tr>
<td>B4</td>
<td>Finnish design code for concrete</td>
</tr>
</tbody>
</table>

To select design codes for different materials, open the Analysis model attributes dialog box. On the appropriate Design tab, select an option from the Design code list box. For more information, see Design codes and methods in the online help.

Omitting individual analysis members from design check

You can now omit individual members from the design check when you run the analysis. To do this, go to the Design tab in the part properties dialog box, and set one of the following properties to No:

- Steel parts: Check design - Enable design check of member
- Concrete parts: Calculate required area - Enable design check of member
The default is **Yes**.

**Optimizing part size**

Tekla Structures optimizes steel part sizes based on the profile weight, and, by default, suggests profiles using profile catalog rules, in the order in which the profiles appear in the catalog. To change this, use the following user-defined attributes:

- The **Design order** attribute defines the order in which Tekla Structures suggests profiles.
- The **Design group** attribute defines the profile groups from which Tekla Structures suggests profiles.
For more information, see Adding user-defined attributes to a profile in the online help.

To have Tekla Structures ignore the profile catalog rules and search the entire profile catalog, set the environment variable
XS_AD_OPTIMISATION_RECURSE_CATALOG to TRUE.

To prevent Tekla Structures from searching for profiles based on the weight, set the environment variable XS_AD_OPTIMISATION_NO_WEIGHT_SORT to TRUE.
Omitting openings when analyzing plates

To have Tekla Structures ignore holes in contour plates, or openings in concrete slabs, when you analyze them, use the Min hole size user-defined attribute on the Analysis tab in the user-defined attributes dialog box for the part. Enter the minimum size of the bounding box around an opening to indicate which openings to consider. The analysis will ignore openings with a smaller bounding box than the value you enter here.

Editing objects.inp

To add user-defined attributes to part dialog boxes, you need to edit the objects.inp file in the ..\environments\country_independent\inp folder, using any standard text editor (for example, Notepad). Save the objects.inp file and restart Tekla Structures for the changes to take effect.

Example

To create a Min hole size field on the Analysis tab, add the following lines to the Part attributes section of the objects.inp file, under tab_page("AnalysisPlates"), and after the other attributes:

```plaintext
attribute("AD_plate_min_hole", "Min hole size", dimension, "%.3f", no, none, "0.0", "0.0")
{
  value("", 0)
}
```

To show the Analysis tab for the appropriate part types, remove the comment marks /* */ around the following line (for example, in the Concrete slab attributes section of the objects.inp file):

```plaintext
tab_page("AnalysisPlates","jd_AnalysisPlates",8)
```

For more information on editing the objects.inp file, see Adding properties and Interpreting objects.inp in the online help.
Fine-tuning analysis models

To control how Tekla Structures creates analysis models, use the new user-defined attributes in the following table. See also A closer look at the analysis model in the online help.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Possible values (in dialog box)</th>
</tr>
</thead>
</table>
| AD_rigid_link      | Allows or disables rigid links at the start, mid, and/or end points of parts. Also works with the Force to centric connection node definition method. | Enter 0 or 1 for start, mid, and end point. 0 disables and 1 allows rigid links. For example:  
  • 0 = no rigid links  
  • 100 = rigid link at start point  
  • 111 = rigid links at start, mid, and end point  
  • 1 = rigid link at end point |
| AD_keep_axis       | Fixes the location of member axis so that Tekla Structures does not shift the axis when it makes members meet in the analysis model. | To fix a member axis, enter 1. |
| AD_keep_start      | Fix the start or end of parts so that Tekla Structures does not move the part ends when it makes members meet in the analysis model. | To fix a part end, enter 1. |
| AD_keep_end        |                                                                           |                                                                                                  |
| AD_clash_with      | Forces or disables connections between the parts you specify.              | To make analysis members meet, enter the part ID’s. Enter negative ID’s to prevent the connection. |

To create fields for these user-defined attributes in part dialog boxes, you need to edit the objects.inp file as explained in Editing objects.inp (p. 37).

The following lines in the Part attributes section of the objects.inp file, under tab_page("AnalysisBeamAndColumn"), create the dialog box fields:

```
attribute("AD_part_rigid_link", "Rigid link", integer,  
  "%d", no, none, "0.0", "0.0", 377, 310)  
  
  value("", 0)  
```
attribute("AD_keep_axis", "Keep axis", integer, "%d", no, none, "0.0", "0.0", 377, 340)
{  value("", 0) }

attribute("AD_keep_start", "Keep start", integer, "%d", no, none, "0.0", "0.0", 377, 370)
{  value("", 0) }

attribute("AD_keep_end", "Keep end", integer, "%d", no, none, "0.0", "0.0", 377, 400)
{  value("", 0) }

attribute("AD_clash_with", "Clash with", string, "%s", no, none, "0.0", "0.0", 377, 430)
{  value("", 0) }

To have Tekla Structures use these settings for an analysis model, select the Extended clash check checkbox in the Analysis model attributes dialog box when you create the analysis model.

**Miscellaneous**

Tekla Structures 10.1 includes the following new features and fixes:

- The filter in the Analysis model attributes dialog box is now a list box and uses standard select filters.
- The analysis method option 2nd order has been changed to Non-linear, so the options are now as follows:

![Analysis model attributes](image)

For more information on analysis methods, see P-Delta Analysis and Non Linear Analysis in the online help.
- The **Analysis & Design models** dialog box now has standard minimize and maximize buttons in the upper right corner of the dialog box.

- Buttons in the **Analysis & Design models** dialog box are now only active when you can use them. For example, if you do not have an analysis model selected, only the **New** and **Close** buttons are active.

- **Analysis & Design models** dialog box

- If you use the **Save** or **Save as** buttons in the part properties dialog boxes, Tekla Structures now also saves the analysis-related user-defined attributes and their values to a properties file.

- Tekla Structures 10.1 only builds the analysis model when you run the analysis, not when you create or modify an analysis model.

- Tekla Structures 10.1 creates analysis models faster when you are working with large models, or if your model contains plates that connect with beams.

- Tekla Structures 10.1 finds colliding parts and common nodes more efficiently when it creates analysis models. It now extends each part’s bounding box by 1 mm to find colliding parts and ignores inner contours. To use this method for an analysis model, select the **Extended clash check** checkbox in the **Analysis model attributes** dialog box when you create the analysis model.

  Tekla Structures 10.0 extended exact part solids by 50 mm. See also **A closer look at the analysis model** in the online help.

- Tekla Structures no longer splits truss members.

- Tekla Structures 10.1 automatically removes all releases from a cantilever member end if:
  - no member is connected to it,
  - no rigid link is connected to it, and
  - the end node is not supported.

- Tekla Structures 10.1 shows a progress bar while it builds analysis models and distributes loads, and gives you the option to cancel creation of the analysis model.
• You can now interrupt the load combination process. This is useful if you have defined incompatible load groups that will result in a large number of load combinations.

• Tekla Structures 10.1 writes warnings in the analysis log file if problems occur during load distribution. To view the analysis log file, click **Tools > Display log file > Analysis log file**.

• Load distribution is more accurate now as Tekla Structures 10.1:
  - Ignores loaded members in the analysis if they are less than 20 mm long.
  - Does not transfer uniform loads to parts which are parallel to the load magnitude.

• If you change the analysis or design properties of a part in an analysis model (for example, support conditions, buckling length), Tekla Structures 10.0 unnecessarily marked the drawings associated to the part affected and recreated the components associated to the part. Tekla Structures 10.1 treats the part as modified and only marks the single-part drawings with P flag, and changes the analysis model status to **Out of date**.

• If you used the **Full model** option to create an analysis model of the entire physical model and then created new load groups and loads, the load groups were not available for load combination. Fixed.

• The **Unl** and **UnF** design properties of steel parts no longer cause conflicts. If you define values for both of them, Tekla Structures multiplies the values and uses the result. If either value is 0, Tekla Structures uses the other value.
1.8 Reinforcement

This section describes the following new features and fixes:

Bent reinforcement meshes

You can create bent reinforcement meshes in Tekla Structures 10.1.

To create a bent mesh:

1. Double-click the Create reinforcement mesh icon to open the Reinforcement mesh properties dialog box.
2. In the Mesh type list box, select Bent.
3. Enter the bending radius.
4. Enter or modify the other mesh properties.
5. Click **Apply** or **OK** to save the properties.
6. Click the **Create reinforcement mesh** icon.
7. Select the part to reinforce. Tekla Structures attaches the mesh to the part.
8. Pick points to indicate the bending shape of the crossing bars.
9. Click the middle mouse button to finish picking points.
10. Pick two points to indicate the length and direction of the longitudinal bars.
Prestressed strands

Tekla Structures 10.1 introduces a new tool to create prestressed strands for concrete parts. This tool appears on the **Detailing** menu and the **Concrete** toolbar.

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Reinforcement strand pattern](image) | Reinforcement strand pattern

Creates straight or deflected strands based on the strand profile you indicate.

Creating strands

To create prestressed strands for a concrete part:

1. Double-click the **Create reinforcement strand pattern** icon.
2. Enter or modify the strand properties.
3. In the **Number of patterns** field, enter a number based on the strand profile. For example:
4. Click **Apply** or **OK**.

5. Click the **Create reinforcement strand pattern** icon.

6. Pick the part you are creating strands for.

7. Pick points to position the strands (for example, at the end of a part). The points you pick define the first pattern. Click the middle mouse button to finish picking.

8. If you chose to create a single pattern, pick two points to define the length of the strands. Click the middle mouse button to finish picking.

9. If you chose to create two or more patterns, for each pattern, pick points to indicate the strand positions. Pick the strand positions in the same order as for the first pattern. After each pattern, click the middle mouse button to finish picking.

<table>
<thead>
<tr>
<th>Strand profile</th>
<th>Number of patterns</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Strand profile 1" /></td>
<td>1</td>
</tr>
<tr>
<td><img src="image2" alt="Strand profile 2" /></td>
<td>2</td>
</tr>
<tr>
<td><img src="image3" alt="Strand profile 3" /></td>
<td>3</td>
</tr>
<tr>
<td><img src="image4" alt="Strand profile 4" /></td>
<td>4</td>
</tr>
</tbody>
</table>
Curved and circular reinforcing bar groups

Tekla Structures 10.1 includes two new tools to create reinforcing bar groups. These tools appear on the Detailing menu and the Concrete toolbar:

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Curved reinforcing bar group](image) | Curved reinforcing bar group  
Creates a group of curved bars based on:  
1. Three points you pick on an arc.  
2. Two points indicating the distribution direction of bars. |

| ![Circular reinforcing bar group](image) | Circular reinforcing bar group  
Creates a group of circular bars based on:  
1. Three points you pick on a circle.  
2. Two points indicating the distribution direction of bars. |
Displaying overlapping bars

Overlapping bars now look more realistic in rendered model views. For example, stirrups have a small gap between the bars where they overlap:

<table>
<thead>
<tr>
<th>Tekla Structures 10.0</th>
<th>Tekla Structures 10.1</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image of Tekla Structures 10.0" /></td>
<td><img src="image2.png" alt="Image of Tekla Structures 10.1" /></td>
</tr>
</tbody>
</table>

Tekla Structures 10.1 automatically uses this new representation:

- In rendered model views
- In drawings, if you use the representation option filled line or double lines for reinforcement
- In the reinforcing bar clash check

Converting concrete cover

Tekla Structures 10.1 handles concrete cover thickness in a different way than Tekla Structures 10.0. So, if you open a model that contains reinforcement and was created in Tekla Structures 10.0, Tekla Structures 10.1 asks you to change all concrete cover thickness values to zero. This moves the handles to the ends and corners of the bars.

![Image of concrete cover conversion](image3.png)
If you click No, Tekla Structures tries to convert the bars and meshes as well as it can, but you should check the model to ensure that bars have not moved or become deformed.

**Reinforcement components**

Tekla Structures 10.1 includes the following new features and fixes:

**Strip footing (75)**
- You can now create main bars and stirrups based on exact or target spacing.
- The **Bend type** list box on the **Stirrups** tab has new, graphic options:

![Diagram of bend type options](image)

**Pad footing (77)**
Use the new **Lacer bars** list box on the **Lacer bars** tab to switch lacer bars on or off.

**Starter bar (78)**
Rectangular stirrups are now a reinforcing bar group, so you can modify them all at the same time.

**Miscellaneous**

Tekla Structures 10.1 includes the following new features and fixes:
- Part representation settings no longer affect reinforcement. Reinforcing bars are now never transparent in model views.
• The following commands on the View menu now also work for reinforcement, and are available on the pop-up menu when you have reinforcing bars selected:
  • Fit work area
  • Fit by parts
  • Create view > Part basic view
  • Create view > Part basic views

• In the Steel Detailing configuration, reinforcing bars now move with the part that contains them.

• You can now number reinforcement in the Reinforced Concrete Detailing configuration.

• You can now bind reinforcement handles to planes in custom components and when you make models parametric.

• Reinforcing bars sometimes moved or disappeared if you shifted the work plane and then used the Edit > Reinforcing bar > Attach to part command. Fixed.

• Tekla Structures no longer omits user-defined attributes for reinforcement in the view filter.
Tekla Structures 10.0 is the next generation of Tekla Xsteel. Its new, modular format spans the entire structural design process; from conceptual design, to detailing, fabrication, and construction. Tekla Structures comes in several configurations, designed to provide solutions for the following processes:

- Steel detailing (former Xsteel)
- Structural engineering
- Concrete detailing (precast and cast-in-place)

This document describes the new features and improvements in the Steel Detailing configuration of Tekla Structures 10.0, since Xsteel 9.1.

**Compatibility**

Tekla Structures is compatible with all previous versions of Xsteel. You can open and work with existing models using Tekla Structures.

We recommend that you complete any models you have started using your current version.

> Once you save a model in Tekla Structures, you can no longer open it in Xsteel versions.

**Installing**

Tekla Structures setup creates following new folders, by default:

- Tekla Structures for programs files
- TeklaStructuresModels for models

You need Windows Administrator rights to install Tekla Structures. This ensures that all Windows system folder *.dll files are updated.
Topics

This chapter is divided into following sections:

- General (p. 52)
- Modeling (p. 57)
- Drawings (p. 66)
- Import and export (p. 73)
- Custom components (p. 75)
- Components (p. 81)

### 2.1 General

This section describes the following new features and fixes:

#### New modular format

The basic steel detailing configuration of Tekla Structures contains the following modules:

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modeling</td>
<td>Tools for creating 3D models and GA drawings. Connections are conceptual. See also Conceptual components (p. 83).</td>
</tr>
<tr>
<td>Model Sharing</td>
<td>Multi-user features.</td>
</tr>
<tr>
<td>Steel Detailing</td>
<td>Detailed steel connections and fabrication information (assemblies, workshop drawings, and CNC features).</td>
</tr>
</tbody>
</table>

You can add the following modules to the basic configuration:

- Analysis and Design
- Tekla Structures Plate Nesting
- CIS/2
- Additional CNC postprocessors (Daito and Peddimat)

To find out which features each module contains, read Tekla Structures modules in the online help.
Available modules

To find out which Tekla Structures modules are loaded on your computer, click Help > About Tekla Structures...:

The system gets this information from your password file.
New XP-style interface

Our usability professionals have created a new, XP-style interface for Tekla Structures. We have improved the toolbars to make them more intuitive and easier to use. Improvements include:

- New, clearer icons
- Icons for most commands
- Icons grouped together on new and existing toolbars in a more logical way.

Here is a complete list of the changes we have made to the toolbars:

- **Publish as web page** added to **Standard** toolbar
- **Move** and **Copy** commands moved to the **Edit** toolbar
- **Bolt** and **Weld** commands moved to the **Steel** toolbar (previously named the **Part** toolbar)
- **Open model folder**, **Angle measure**, and **Bolt measure** commands added to the **Tools** toolbar.
- All point commands grouped on the **Point** toolbar
- New work area and work plane commands on the **View** toolbar.
- **Zoom** commands moved to the new **Window** toolbar.
- **AutoConnection** added to the **Component** (previously connection) toolbar.
- Two new commands for removing dimension point circles added to the **Dimensioning** toolbar.
- Improved location for drawing **Edit**, **Interrupt**, and **Snap** toolbars.
- **Edit** and **Window** menus moved to standard Microsoft Windows locations.
New component catalog

The new component catalog contains most of the connections, details and macros available in Tekla Structures. Use the tools in component catalog to:

- Search for connections, details, and macros using name, number, or keywords
- Create a list of favorite components
- Define keywords for one or more components
- Import and export custom components.

To open the component catalog, use the keyboard shortcut Ctrl + F or click the binocular icon on the component toolbar:

This example shows the results for the search term "gusset".

<table>
<thead>
<tr>
<th>Name</th>
<th>Number</th>
<th>Keywords</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bolted gusset (11)</td>
<td>11</td>
<td>All &quot;Search result&quot;</td>
</tr>
<tr>
<td>Corner bolted gusset (57)</td>
<td>57</td>
<td>All &quot;Search result&quot;</td>
</tr>
<tr>
<td>Corner tube gusset [56]</td>
<td>56</td>
<td>All &quot;Search result&quot;</td>
</tr>
<tr>
<td>Corner wrapped gusset (63)</td>
<td>63</td>
<td>All &quot;Search result&quot;</td>
</tr>
<tr>
<td>Double Bent G ussets [140]</td>
<td>140</td>
<td>All &quot;Search result&quot;</td>
</tr>
<tr>
<td>Gusset stiffeners (171)</td>
<td>171</td>
<td>All &quot;Search result&quot;</td>
</tr>
<tr>
<td>Gusset in bolts (549)</td>
<td>49</td>
<td>All &quot;Search result&quot;</td>
</tr>
<tr>
<td>Gusset in points (547)</td>
<td>47</td>
<td>All &quot;Search result&quot;</td>
</tr>
<tr>
<td>Gusset wrapped dia (62)</td>
<td>62</td>
<td>All &quot;Search result&quot;</td>
</tr>
<tr>
<td>Standard gusset (1065)</td>
<td>1065</td>
<td>All &quot;Search result&quot;</td>
</tr>
<tr>
<td>Tube gusset (20)</td>
<td>20</td>
<td>All &quot;Search result&quot;</td>
</tr>
<tr>
<td>Welded gusset (10)</td>
<td>10</td>
<td>All &quot;Search result&quot;</td>
</tr>
</tbody>
</table>

The Macros list has been removed from the Properties menu. Some rarely-used macros do not appear in the component catalog. To add them, use through the Customize dialog box.
Warning before password expires

Tekla Structures now warns you that your password file is about to expire:

The warning appears at the following intervals before your password expires:

- Less than one month - once
- Two weeks - once
- Seven days - every time you start Tekla Structures.
2.2 Modeling

This section describes the following new features and fixes:

**Modeling concrete members**

The *Parts* menu contains several improved tools for modeling concrete members:

<table>
<thead>
<tr>
<th>Command</th>
<th>Image</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pad footing</td>
<td><img src="image" alt="Pad footing" /></td>
<td>Creates a pad footing at a point you pick.</td>
</tr>
<tr>
<td>Strip footing</td>
<td><img src="image" alt="Strip footing" /></td>
<td>Creates a strip footing that traverses the points you pick.</td>
</tr>
<tr>
<td>Concrete column</td>
<td><img src="image" alt="Concrete column" /></td>
<td>Creates a concrete column at a point you pick.</td>
</tr>
<tr>
<td>Command</td>
<td>Image</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Concrete beam</td>
<td><img src="image1.png" alt="Concrete Beam Image" /></td>
<td>Creates a concrete beam that traverses the points you pick.</td>
</tr>
<tr>
<td>Concrete slab</td>
<td><img src="image2.png" alt="Concrete Slab Image" /></td>
<td>Creates a concrete slab based positions you pick to indicate the outline.</td>
</tr>
<tr>
<td>Concrete panel</td>
<td><img src="image3.png" alt="Concrete Panel Image" /></td>
<td>Creates a concrete panel that traverses the points you pick.</td>
</tr>
</tbody>
</table>
Creating loads

Tekla Structures includes new tools for creating loads in a model. If you have the Analysis and Design add-on module, you will be able to analyze structures after you have created loads and assigned them to members.

Tekla Structures contains the following load types:

To create loads, you need to create **Load groups**, and then use the following commands on the **Loads** menu:

<table>
<thead>
<tr>
<th>Command</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Point load</strong></td>
<td>![Point load icon]</td>
<td>Creates a concentrated force or bending moment that you can attach to a part.</td>
</tr>
<tr>
<td><strong>Line load</strong></td>
<td>![Line load icon]</td>
<td>Creates a linearly-distributed force or torsion that you can attach to a part. By default it runs from one end of the part to the other. Its magnitude can vary linearly across the loaded length.</td>
</tr>
<tr>
<td><strong>Area load</strong></td>
<td>![Area load icon]</td>
<td>Creates a linearly-distributed force bounded by a triangle or quadrangle. You do not have to bind the boundary of the area to parts.</td>
</tr>
<tr>
<td><strong>Uniform load</strong></td>
<td>![Uniform load icon]</td>
<td>Creates a uniformly-distributed force bounded by a polygon. You do not have to bind the polygon to parts.</td>
</tr>
</tbody>
</table>
Use formulas in copy and move

Now you can use formulas in the Copy - translate and Move - translate dialog boxes, instead of calculating distances yourself. For example, to copy a part to three spans away, type 3* and the size of the span in the dY field.

The formula must begin with the equals sign (=):

<table>
<thead>
<tr>
<th>Command</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| Temperature load   |      | Creates a temperature load that you can attach to a part. You have the following options to define the load:  
|                    |      | • temperature change of part  
|                    |      | • temperature difference along part  
|                    |      | • strain  
| Wind load          |      | Automatically generates wind loads around the selected structure.           |

With imperial units, you can use formulas only with decimal inches.
**Improved edge distance checks**

Tekla Structures always checks edge distance when it creates bolts.

**Bolt or hole diameter**

Now you can choose to base the edge distance check on the diameter of the bolt or the hole. Previous versions always based the check on the diameter of the bolt.

To specify which diameter to use, go to the **Element considered** field in the **Options** dialog box and select either **Bolt diameter** or **Hole diameter**.

**Slotted holes**

Tekla Structures now correctly calculates the center of slotted holes:

![Slotted hole edge distance is now calculated from these points.](image)

Previous versions treated slotted holes as round holes in edge distance checks.

**Continuous surfaces**

Edge distance checks on continuous surfaces (like angles) are now more accurate. For example, in the inside corner of an angle, Tekla Structures checks edge distance is greater than hole radius to ensure that holes do not touch other surfaces.

![This distance is checked against the minimum edge distance (ratio * Hole/Bolt diameter)](image)

![This distance is checked against the hole radius.](image)

These settings for edge distance checks do not affect bolt clash checks.
Free measure displays more information

The Tools > Measure > Free command now displays dimensions in the format dimension (x, y, z):

382.47 (322.88, 223.13, 0.00)
Faster display and hide commands in views

Displaying and hiding objects from views is now much faster. Tekla Structures only redraws objects if you have changed their display properties in the View setup dialog box.

Planes

The View setup dialog box contains the following new switches:

- User planes
- Loads
- Reinforcing bars.
Construction line length and color

You can now specify the color of construction lines and circles, and change the length of construction lines:

![Construction line length and color screenshot](image)

Tekla Structures draws construction lines in existing models in yellow.

Less repetition in objects.inp

The structure of the objects.inp file has changed. You can now group attributes and define them on common tab pages, then use those definitions for different part types, as shown below:

First, define the common tab pages in the Part attributes section:

```plaintext
/************************************************************/
/* Part attributes */
/************************************************************/
part(0,"Part")
{
    /* Common part attribute tab pages */
    tab_page("Parameters")
    {
        attribute("comment", "j_comment", string, "%s", no, none,
                    "0.0", "0.0")
        {
            value("", 0)
        }
        attribute...
    }
    tab_page("Parameters","jd_Parameters",4)
    modify(1)
}
```
Then use definitions on the common tab pages for different part types:

```plaintext
beam(0,"Beam")
{
  tab_page("Parameters","jd_Parameters",4)
  modify(1)
}
```

**Previous versions**

Tekla Structures can read objects.inp files created for previous versions.

**Miscellaneous**

- **Angle measure** now displays the information in the correct plane.
- Macro symbols now also move when you use the Move command to move a part.
- When you rotate a rendered plane view to a 3D view, and then change the part representation, the view no longer changes back to a plane view.
- When you use a white background while modeling, Class 1 lines are now dark gray. This makes them easier to see.
- The Copy from model command now creates connections in the right position.
- The Fly command now has new shortcut, Shift + F. The shortcut Ctrl + F is used to find a component.
- In Xsteel 9.1 the cursor did not snap to lines in component objects, if the Select parent switch was active. Snapping was only possible when Select objects in components was active. Fixed.
- ø or Ø are now accepted as parametric profile prefixes in Windows XP. (This was not a problem in Windows 2000).
- The Polygon cut command now works when you select several parts using a crossing window.
- Phase manager dialog box no longer disappears when you save in multiuser mode.
• The Plot dialog box now keeps the Plot to file setting.
• Clash check now gives the same result, regardless of the picking order.
• Bolts with negative cut length are now shown correctly with solid representation.
• The enclosing window selection tool no longer selects parts with only one handle inside the selection area.
• The Inquire object dialog box now displays width for contour plates.

2.3 Drawings

The Drawing Editor contains new commands for easier editing.

White background

Drawings in the Drawing Editor now have a white background, giving you a more accurate preview of the output:

More colors

You can now use up to thirteen colors in drawings. Previous versions only offered eight.
Colored or black lines

You can use colored or black lines on a white background. To switch between color and black, use the keyboard shortcut B or the command Setup > Black and white drawing.

Tekla Structures shows line thickness in the Drawing Editor. Define line thickness in the **Color table** for the first plotter in the plotter catalog (usually the DWG plotter). Enter the line width in pixels in the **Pen number** field. Line thickness is always visible in black and white mode. In color mode, use the command Setup > **Use plotter line widths** to switch line thickness on or off.
**Lengthen or shorten lines**

Use the new Trim command to lengthen or shortens lines relative to a boundary. The boundary does not have to be a line. For example, it can be a part, arc, or rectangle.

**Cutting**

To cut a line:

1. Click Edit > Trim.
2. Click on the cutting line.
3. Click the middle mouse button.
4. Click the side of the horizontal line to cut it at the boundary line.

**Extending**

To extend a line:

1. Click Edit > Trim.
2. Click on the boundary line.
3. Click the middle mouse button.
4. Click the right end of the horizontal line to extend it to the boundary line.

**Splitting objects into two pieces**

Use the new Split command to cut the following objects into two pieces, at a specific point:

- Lines
- Polylines
- Rectangles
- Circles
- Arcs
To split a line:
1. Select the line.
2. Click Edit > Split.
3. Pick a point to indicate the cutting location.
4. Tekla Structures splits the line into two lines:

Dividing objects into several pieces

Use the new Divide command to divide the following objects into several pieces:

- Lines
- Arcs

To divide a line into four:
1. Select the line.
2. Click Edit > Divide. The Segments dialog box appears.
   
   
   ![](image1.png)

3. Enter "4" and click OK.
4. Tekla Structures divides the line into four equal lines:
Inquire drawing objects

You can now use the Inquire command to view the properties of drawing objects. Use one of the following methods:

- Inquire > Inquire object,
- The Inquire icon
- Right-click a part and select the Inquire option on the popup menu.

Short extension lines in dimensions

You can now create extension lines in drawings that are all the same length:

To create extension lines all the same length:

1. In the drawing properties dialog box, click Dimension... > Short extension line (Yes).
2. To adjust the length of the extension line, use the following environment variables:

   set XS_DIMENSION_EXTENSION_LINE_TOWARD_FACTOR=1.5
   set XS_DIMENSION_EXTENSION_LINE_AWAY_FACTOR=1.0

Templates and reports

Tekla Structures contains the following new template fields:

- ASSEMBLY_PREFIX
- ASSEMBLY_SERIAL_NUMBER
- PART_PREFIX
- PART_SERIAL_NUMBER
In drawing templates, use the following new fields to display information about the main part in a drawing:

- `DR_ASSEMBLY_PREFIX`
- `DR_ASSEMBLY_SERIAL_NUMBER`
- `DR_PART_PREFIX`
- `DR_PART_SERIAL_NUMBER`

** Fixes **

The following problems have been fixed:

- `ASSEMBLY_POSITION_CODE` changed in reports or drawings each time you saved a drawing.
- The `BOLT` report template did not create a list of bolts if you only selected bolts in the model (if you selected the parts that were bolted, the report was correct).
- The `ASSEMBLY_STUD` template type did not work correctly. If you used the `assembly_stud_list` report with the `Create from selected` option, it did not display an assembly information and objects were listed in the wrong order (`Create from all` worked fine).

** Miscellaneous **

- You can now omit the part prefix from part marks in drawings and only display the serial number. To do this, use the template fields `ASSEMBLY_SERIAL_NUMBER` or `PART_SERIAL_NUMBER` in the `Used-defined attribute` element in part mark contents.
- Using the wizard to create multidrawings no longer causes an application error.
- Drawing dialog boxes contain two new line types:
  
  ![Line types](image)
  
  - Drawing component properties could not be saved. Fixed.
  - Duplicate end absolute dimensions have been removed. To revert to the previous functionality (all dimensions), set `XS_DO_NOT_REMOVE_END_ABSOLUTE_DIMENSIONS=TRUE`. 
• Weld length is no longer overwritten if the weld mark also contains the pitch. In previous versions, the second apostrophe in the inch symbol (") was overwritten to appear as 3’@12”.

• You can now change bolt size limit after a drawing is created.

• Bolt and weld size limits did not work when properties changed. Bolt marks were not deleted when the limit was changed. Fixed.

• Occasionally, some skewed bolt dimensions were not dimensioned in single part drawings, even if the environment variable `XS_DIMENSION_SKEWED_BOLTS_INPART_PLANE_IN_SINGLE_DRAWINGS` was set. Fixed.

• Picking circle with 3 points did not work correctly. The center point was the same as the third point if you picked points clockwise. Fixed.

• It was not possible to pick in the hatch selection window. Fixed.

• The drawing list sometimes disappeared from the screen. This required a restart. Fixed.

• Modifying neighbor part marks at the view level did not work in GA drawings. Fixed.

• Manually-added weld symbols now correctly retain their object level properties if you modify the drawing properties.

• Opening a multidrawing immediately after editing caused ID conflicts. So, adding drawing objects sometimes deleted existing drawing objects. This did not happen if you closed the drawing after editing or opened another drawing. Fixed.

• The drawing Select filter dialog box now automatically closes when you close the Drawing Editor and open the Model Editor.

• Some orientation marks were not correctly placed in GA drawings. Placing beam part marks placing according beam orientation only took into account modeling direction, not solid geometry. Fixed.

• You can now place part marks or other text upside down to illustrate that identical parts have different orientation. To do this, set the environment variable `XS_UPSIDE_DOWN_TEXT_ALLOWED=TRUE`. If you do not set this variable, Tekla Structures automatically changes all marks or text that are rotated more than 90 degrees.

• To dimension the overall length of tube profile along the inner surface instead of outer surface, set the environment variable:
  `XS_USE_TUBE_INNER_LENGTH_INDIMENSIONING=TRUE`

• Bolt hole symbols were incorrect in workshop drawings if bolt direction was not perpendicular to the view plane. Fixed.
Combining bolt dimensions when using absolute dimensioning failed to combine the last group of holes. Fixed.

2.4 Import and export

This section describes the following new features and fixes:

Import Cadmatic models

You can now import Cadmatic models into Tekla Structures as a reference model. The file extension for Cadmatic models is 3dd.

New plate nesting features

The plate nesting tool is now called Tekla Structures Plate Nesting. It has been renewed and contains new features. Its also contains all the DSTV2DXF options.

Improved WebViewer

Tekla WebViewer contains the following improvements:

• WebViewer displays the biggest parts first.
• New Copy and paste location commands on the pop-up menu.
• The Send WebViewer link command automatically adds the location information of the current view to the email message.
• Improved visibility in wireframes.
• Rotate the model using the Ctrl key and the middle mouse button.
• New command to set the view point (shortcut V).
• New sample named views.

New part length calculation in MIS export

Tekla Structures calculates part length in MIS exports (Steel2000, EJE, KISS, EPC, and DSTV formats) from unfolded parts using the settings in the unfold_corner_ratios.inp. Previously, part length was based on the center line of the part. This could cause problems, particularly with folded plates created using the Polybeam command.

To continue to use the previous functionality, set these environment variables as shown:

```
set XS_USE_OLD_POLYBEAM_LENGTH_CALCULATION=TRUE
rem set XS_CALCULATE_POLYBEAM_LENGTH_ALONG_REFERENCE_LINE=TRUE
```
**Miscellaneous**

- **Import CAD** dialog box did not close with the **OK** button. Fixed.
- You can now select an unlimited amount of objects in SDNF exports. Also, you no longer have to select polygon cuts in contour plates to include them in SDNF exports.
2.5 Custom components

Custom elements are now called custom components. You can now define custom parts and seams, as well as custom connections and details.

Custom components contain the following new features and fixes:

Create custom parts

A custom part is a group of objects that you can place in a model by clicking one or two points. Custom parts can contain connections and details, so you can use them to create very complex structures.

Here are some examples of custom parts.
Create custom seams

Create custom seams to use between two parts, for example concrete panels or slabs. Seams are also useful in steel clad structures. A seam can include:

- Cuts or fittings
- Connecting pieces
- Grouting

Custom seams do not split one piece into two pieces.

This example shows a custom seam between two wall panels.

It creates polygon cuts and reinforcing bars along the seam.
To define a seam, use the **Custom component wizard**.

When you define and use a custom seam, you need to specify:

- Seam objects
- The primary part
- The secondary part
- Two points to define the start and end point of the seam

If you want a custom seam to adapt to changes in the model, for example, different panel heights, use the custom component editor to add intelligence to the seam.

**Combine several components**

A custom component can now contain:

- Other custom components
- System components

For example, you can create a custom connection that contains a system connection to create notches and a system detail to create stiffeners.
Create several connections between the same parts

Now you can use a single custom connection several times on the same primary and secondary parts. For example, you can make a splice connection between two beams using several shear plate connections to the flanges and webs of the beams.

To use this feature, select the **Allow multiple instances of connection between same parts** checkbox in the custom component wizard.

Visible default values

The custom component dialog box now displays default values in square brackets:

```
[800.0]
```

The default values are defined in the custom component editor.

When you edit a default value, the square brackets disappear and your value overrides the default value. Tekla Structures does not recalculate overridden values.

To restore the default value:

1. Select the component symbol.
2. Delete the value from the field.
3. Click **Modify**.
4. Click **Get** to make the default value visible in the field.

**More objects with handles**

The following objects now have handles

- User planes
- Polygon welds
- Custom components

**New parametric properties**

The following properties have been added to connection objects:

- Weld length above line
- Weld length below line
- Weld type above line
- Weld type below line
- Assembly number prefix
- Assembly start number
- Chamfer type
- Chamfer dx
- Chamfer dy
- Rebar group properties:
  - Number of reinforcing bars
  - Target spacing value
  - Exact spacing value
  - Exact spacing values
**Improved magnetic plane**

The following image shows how the functionality of magnetic user planes has changed. The columns are only bound to one magnetic plane. When you rotate the plane, the columns in this example move linearly along the grid lines.

**Xsteel 9.1:**

**Tekla Structures 10.0:**

---

**Miscellaneous**

- You cannot place the custom component editor toolbar between other toolbars. It always floats.
- Some planes were missing in some shapes of contour plate. Fixed.
- Custom connections did not work correctly with AutoConnection, as follows:
  - Using two, one-sided connections did not work when there were two sides. Fixed.
  - When creating multiple connections from the same framing condition. Fixed.
- **Get** now correctly enters the **Connection code** and **Class** properties of the selected custom component in the dialog box.
- The **Inquire** command works faster for plane names.
- If you used area selection to create several custom connections, the connection was only applied to one secondary part. Fixed.
## 2.6 Components

This section describes the following new features and fixes:

### New built-up components

Tekla Structures introduces several new components to connect tapered built-up members:

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Example" /></td>
<td><strong>Tapered beam to column (197)</strong> connects a built-up beam to a built-up column.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Example" /></td>
<td><strong>Tapered column to beam (199)</strong> connects a built-up column to a built-up beam.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Example" /></td>
<td><strong>Tapered beam to beam (200)</strong> connects two built-up beams with stiffened endplates.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Example" /></td>
<td>The <strong>Tapered base plate (1068)</strong> detail creates a stiffened base plate to the built-up column.</td>
</tr>
</tbody>
</table>
New cast-in plate detail (1069)

Tekla Structures includes a new cast-in plate detail. This creates an embedment plate and connects it to the steel beam using shear plate(s) or angle(s).

Use one of the following to anchor the plate to the concrete:

- Studs
- Straight anchor rods
- Bent anchor rods

You can also create 2 or 4 nail holes.

The detail also suits for skew situation.
Conceptual components

Tekla Structures includes conceptual components. Typically, engineers and designers create conceptual components. They are similar to standard components, but they do not contain fabrication information (position numbers, workshop welds or bolts). Conceptual components have a rectangular component symbol in the model.

You cannot create conceptual components in the Steel Detailing configuration that you are using, but you can change a conceptual component into a detailed component. To do this, right-click the component symbol and select Change to detailing component.

For more information, see Conceptual components in the Detailing Manual.

Hide component objects easily

The Hide object command now also hides component objects when the Select component switch is on. This means that you can now hide all the parts a component creates, with a single mouse click.

AutoDefaults improvements

Tekla Structures now saves the rules and attribute files used to create a connection in the user-defined attributes of the connection. Use the Inquire command to see them.

AutoDefaults iteration did not work when you copied connections. Tekla Structures iterated the original connection twice (green symbol), but only iterated the copied connections once (yellow symbol).
AutoConnection improvements

All connections now get the default option for the **Hole type** and **Slots** fields when you use AutoConnection to create the connection.

AutoConnection now creates connections for beams and double tee slabs correctly when:
- The slabs connect to the beam from both sides.
- The slab connects to the beam near the endpoint of the beam.

Shear tab connections

When you use the automatic plate side option on the **Plates** tab, Tekla Structures checks that the main part and the shear tab have a contact surface. If not, Tekla Structures places the shear tab to the other side of the secondary part web.

Connections with stiffeners

It is now possible to apply connections or details to a main part if a parallel secondary part has been welded to it.

Beam to beam connections

**Stiffened shear plate (17)**
Did not create the stiffener, or created it incorrectly, if the stiffener was perpendicular to the main beam. Fixed.

**Cranked beam (41)**
Picking order added to the **Picture** tab.

**Welded beam to beam (123)**
Now correctly creates a flange cut if the main part is U profile. Also, it no longer trims the flange if the secondary beam is a U or C profile.

No longer allows the edge of the cutting part to be in the same location as the edge of the beam to be cut. This prevents solid errors.

**Two-sided clip angle (143)**
This connection now creates clip angles correctly on the second side of the secondary part, if secondary parts are channel sections.
Shear plate simple (146)
You can now define the radius of the rathole in the bottom flange, on the Beam cut tab.

Full depth S (185)
The shear plate no longer collides with the primary beam flange when the secondary part has a larger profile height than the primary beam.

Beam to column connections

Column with stiffeners (182)
The following problems have been fixed:
• The connection plate was always rectangular in built-up columns. The plate is now the same shape as for I-profile columns. It is also fills the entire gap between the stiffeners.
• The connection created a plate on the far side.

Stiffener shape
Connections 182 and 187 now contain a new option for shaping the stiffeners on the secondary beam side:

Gusset connections

Corner wrapped gusset (63)
Connection symbol colors now work correctly. Previously, the connection symbol was always red.
Gusset stiffeners (171)
Now automatically detects bracing parts connected to the gusset and adjusts the stiffener dimensions as follows:

- If there are two bracing parts connected to the gusset, it only creates middle stiffeners. If not, it only creates upper and lower stiffeners.
- If the bracing part is not perpendicular to the main part, it checks the shape of the gusset plate:
  - If the plate is square, it creates both upper and lower stiffeners, if they do not clash with the bracing.
  - If one edge of the plate matches the orientation of the bracing, it only creates the stiffener to this side.

Cold Rolled

UltraZED Cold rolled sleeved (107)
Bolt holes are now correctly located in the purlin or rail cleats. Welded cleats no longer contain too many holes, with some in the wrong place.

Wards
The following problems have been fixed:

- Wards stays did not go through in the file transfer
- Wards eaves cleats bolted/welded did not go through in the file transfer
- Incorrect number of welded cleats.

Macros

This section describes the following new features and fixes:

Batten plates (S85)
Bolt group location dimensions now contain default values. This macro did not work well if these fields were blank.

Handrails
- Stanchion cut tolerance now works correctly when Other rail cuts is either At max length or At max stanchion.
- The parameter for offsetting rails now works correctly.
• When you use different profiles for the closure and the top rail, the orientation is now correct.

• The closure at the end farthest from the macro symbol now works correctly in Railings (S77)

You can now use custom components in the Stanchions (S76) and Railings (S77) macros. To do this, enter -1 in the Connection number field and then enter the custom component name in the Settings field.

Stanchions (S76) now correctly displays the connection symbol.

Improved stairs macros

Stairs macros S82, and S71 to S74 contain the following improvements:

• Steps now follow the line you pick. When you use offsets, the stringer moves, not the steps.
• The options for adjusting the distance between the nose of the step and the top of the stringer have been fixed.

Polybeam pan (S73) no longer:

• Generates unnecessary warnings in the log file
• Creates corrupt profiles if you rotate the current work plane

Stair (S74) gave an odd result if you defined the length of the bottom landing. Tekla Structures now creates a landing plate of the correct length.

Stair (S82) only created the stringer to the second tread from the top, not the end point. Fixed.

Stairs (S35) no longer loses part ID numbers if you modify it.

Joist to Column, type 2 (163)

Joist (163) took 10 times longer to apply when used after connection 141. Fixed.

Details

This section describes the following new features and fixes:

Base plate details

Base plate details include the following improvements:

• Anchor rods now have assembly and part prefixes
• New **Grout thickness** field on the **Anchor rods** tab. This helps you to model columns to the top of concrete parts and place the base plate correctly. It also makes it easier to dimension the detail in GA drawings.

![Grout thickness field](image)

To create grouting, enter a value for **Grout thickness** on the **Anchor rods** tab.

• New options to switch bolt direction. Previously there was only one option - bolt head underneath and nut on top.

![Bolt direction options](image)

• More washer(s) added.
• Anchor rods now use the number and spacing values on the **Bolts** tab.
• Deleting bolt number 4 no longer causes problems.
• Deleting an anchor rod from a group no longer creates double rods.

**Base plate (1042)**

You can now define web and flange welds separately. Previously all welds took their size from the web weld value.

**LProf Base detail (1020)**

New picture and tooltip text corrected.

**U.S. Bearing plate (1044)**

• Studs are now created on the far side of the beam.
• Assembly type options for studs (Site, Workshop) now work.
Joist Bearing Plate (1067)

The cut-back dimension for the bottom chord has been fixed.